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1. EINLEITUNG 

1.1. BOT’N ROLL ONE A 

1.1.1. BOT’N ROLL ONE A - FÜR WEN IST DIESER ROBOTER GEDACHT? 

Der Arduino-kompatible Bot’n Roll ONE A ist ein Open Source-Didaktikroboter für alle, die ohne viel 
Vorwissen über Elektronik oder Computer in die Welt der mobilen Roboter einsteigen wollen. Beim 
Zusammenbauen dieses Roboters kann man erste Erfahrungen mit einigen der gebräuchlichsten 
Elektronikbauteile sammeln. In dieser Bauanleitung werden in einer kurzen Einleitung zunächst die 
Grundkomponenten vorgestellt. Weitere Begriffe und Zusammenhänge werden im Rahmen der 
Montageanleitung erläutert, sodass die Nutzerinnen und Nutzer parallel zum Zusammenbau der 
Elektronik eine sehr hilfreiche Einführung erhalten. 

Für Robotik-Neulinge ist der Bot'n Roll ONE A der ideale Einstiegsroboter, weil er sich ohne 
Grundkenntnisse zusammenbauen lässt. 

Für Lehrkräfte ist der Bot'n Roll ONE A ein wertvolles Arbeitsinstrument, das sie bei der 
Wissensvermittlung unterstützt. An diesem Roboter lassen sich verschiedenste Zusammenhänge – von 
der Elektronik bis zur Programmierung – sehr praxisorientiert studieren. 

Aber auch Robotik-Erfahrene stellt dieser Roboterbausatz vor interessante Aufgaben. Der Bot'n Roll ONE 
A ist mit zwei Mikrocontrollern ausgestattet: einem ATmega328, der mit einer Taktfrequenz von 16 MHz 
betrieben und mit Arduino IDE (die stark dem Arduino UNO ähnelt) in der Programmiersprache C 
programmiert wird, und einem PIC18F45K22, der mit einer Taktfrequenz von 80 MHz betrieben und mit 
dem Mikrochip MPLABX (der mit der von botnroll.com entwickelten Firmware mitgeliefert wird) ebenfalls 
in der Programmiersprache C programmiert wird. Für die Interaktion zwischen den beiden 
Mikrocontrollern sorgt eine Library für die Arduino-IDE, die speziell von botnroll.com entwickelt wurde. 
Im Lieferumfang des Bausatzes ist ein 2-zeiliges alphanumerisches LCD-Display mit 16 Zeichen pro Zeile 
enthalten. 

Der Roboter kann mit einer Vielzahl von Arduino-kompatiblen Shields (Aufsteckplatinen) – zum Beispiel 
für drahtlose Kommunikation, GPS oder GPRS – und vielen anderen Sensoren für verschiedenste 
Aufgaben kombiniert werden. Dadurch eignet er sich gut für die Teilnahme an großen nationalen und 
internationalen Robotik-Wettkämpfen. Diese Wettkämpfe sind für junge Menschen immer eine gute 
Motivation, ihr Wissen zu erweitern und neue Lösungen kennenzulernen, die die anderen Teams 
erarbeitet haben. 

Wenn Ihr nähere Informationen wünscht, könnt Ihr Euch auf www.botnroll.com anmelden, damit Ihr 
aktuelle Nachrichten erhaltet. 
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1.1.2. BOT’N ROLL ONE A – DIE WICHTIGSTEN DATEN 

 

Mikrocontroller: 1 ATmega328 + 1 PIC18F45K22 

Versorgungsspannung: 7 V bis 15V DC 

Digitale Ein-/Ausgänge: 14 (davon 6 PWM-fähig) 

Analoge Eingänge: 6 (ATmega328) + 8 (PIC18F45K22) 

Fest zugeordnete Ausgänge für die Servosteuerung: 2 (PIC18F45K22) 

Encoder-Eingänge: 2 (PIC18F45K22) 

I2C-Steckverbinder: 4 (ATmega328) 

LCD-Display: Alphanumerisches Display mit 2 x 16 Zeichen und Helligkeits- und Kontrasteinstellung 
(PIC18F45K22) 

Drucktaster: 3 (PIC18F45K22) 

Hindernissensoren: 2 (PIC18F45K22) 

Buzzer: 1 (ATmega328) 

Debug-LEDs: 2 

Motoren: 2 (PIC18F45K22) 

• Nennspannung: 12 V DC 
• Nennstrom: 0,58 A 
• Drehzahl ohne Last: 250 U/min 
• Nenndrehmoment: 1,16 kg/cm 
• Maximales momentanes Drehmoment: 1,74 kg/cm 

Abmessungen: 205 mm x 192 mm x 85 mm 

Gewicht: 800 g (Basis-Bausatz ohne Akku) 

Akku: Ni-MH-Akku AA 12V 1300 mAh  

Weitere Merkmale: 

• Reset-Taster; 
• Stromkreis zum Messen der Akkuspannung 
• Anbaumöglichkeit für einen Spannungsregler für die Servo-Stromversorgung; 
• Mikrocontroller kommunizieren über SPI-Bus; 
• Kurzschlussschutz durch träge 4A-Sicherung.  
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1.1.3. DER BOT’N ROLL ONE A IM ÜBERBLICK 

 

 

  

 

Abbildung 1: Der Bot’n Roll ONE A im Überblick 
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1.2. ROBOTERTECHNIK 

1.2.1. EIN GESCHICHTLICHER RÜCKBLICK 

Das Wort „Roboter“ trat zum ersten Mal 1920 in Erscheinung – in dem 
Theaterstück „RUR“ (Rossumovi Univerzální Roboti; zu Deutsch „Rossums 
Universal-Roboter“) des tschechischen Dramatikers Karel Čapek. Das Stück 
handelt von dem Unternehmen RUR, das mehrere künstliche Menschen 
herstellt, die dann als Arbeitskräfte eingesetzt werden. Dabei wird erstmals 
das Wort „Roboter“ als Bezeichnung für einen künstlichen Menschen 
verwendet. Das tschechische Wort „robota“ heißt eigentlich „Frondienst“ oder 
„Zwangsarbeit“. Vielleicht liegt es an dieser Nebenbedeutung, dass Roboter 
vielfach mit der Industrie in Zusammenhang gebracht werden. Vor Čapeks 
Theaterstück bemühte man für Roboter das griechische Wort „automaton“, 
das so viel heißt wie „sich selbst bewegend“. 

 

 

1.2.2. DIE DREI GESETZE DER ROBOTIK 

Diese Gesetze, die der Schriftsteller Isaac Asimov in seiner 
Kurzgeschichtensammlung I, Robot aufgestellt hat, formulieren drei 
wichtige Verhaltensvorschriften für Roboter: 

1. Gesetz: Ein Roboter darf keinem Menschen schaden oder durch 
Untätigkeit einen Schaden an Menschen zulassen. 

2. Gesetz: Ein Roboter muss jeden von einem Menschen gegebenen 
Befehl ausführen, aber nur, wenn dabei das erste Gesetz nicht gebrochen 
wird. 

3. Gesetz: Ein Roboter muss seine eigene Existenz bewahren, es sei denn, 
dies spricht gegen das erste oder zweite Gesetz. 

Nach eigener Aussage wollte Asimov mit diesen Gesetzen die 
Rahmenbedingungen für Roboter schaffen, die intelligent genug sind, 
um zwischen Gut und Böse zu unterscheiden, und sich nicht gegen die 
Menschenwelt erheben. Später fügte Asimov noch ein viertes Gesetz 
hinzu: 

Das Nullte Gesetz: Ein Roboter darf die Menschheit nicht verletzen oder durch Passivität zulassen, dass 
die Menschheit zu Schaden kommt. 

 

Das Nullte Gesetz wirft allerdings das Problem auf, dass nach diesem Gesetz in bestimmten Situationen 
der Roboter darüber entscheidet, ob sich die Interessen der Menschheit mit den Interessen des Einzelnen 
überschneiden. Dadurch entsteht ein gefährliches Vakuum für eine Diktatur der Maschinen, die selbst 

Abbildung 2:  
Rossums Universal-Roboter 

Abbildung 3: Das Buch „I Robot“ 
von Isaac Asimov 

http://de.wikipedia.org/wiki/Isaac_Asimov
https://de.wikipedia.org/wiki/I,_Robot_(Film)
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festlegen, was das höchste Gut ist, und Menschen auch schaden können, wenn sie der Meinung sind, dass 
dies für die Menschheit das Beste ist. 

Asimovs Verhaltensvorschriften sind keine Gesetze im eigentlichen Sinn, sondern nur Leitlinien, die alle 
Robotikbegeisterten und Forscher beherzigen sollten, wenn sie Roboter konstruieren und entwickeln. 

 

 

1.2.3. WICHTIGE EVENTS UND VERBÄNDE IN DER WELT DER ROBOTIK 

RoboCup® - http://www.robocup.org/ 

Der RoboCup ist eine weltweite Forschungs- und Bildungsinitiative, die es sich vor allem zur Aufgabe 
gemacht hat, künstliche Intelligenz und die Robotik insgesamt zu fördern. Als zentrale Herausforderung 
dient dabei das Fußballspielen: In allen Robotikbereichen werden neue Technologien entwickelt, damit 
2050 ein Team von Roboter gegen die „menschlichen“ Fußballweltmeister gewinnen kann. Der RoboCup 
findet jedes Jahr in einem anderen Land statt. 

S.P.R. - http://www.spr.ua.pt/site/ 

Die Sociedade Portuguesa de Robótica (Portugiesische Gesellschaft für Robotik, kurz SPR) ist ein 
gemeinnütziger Verein, der vor allem Bildung, Forschung und Technologieentwicklung fördert und anregt, 
sich aber auch für Robotikanwendungen in Industrie und Dienstleistungssektor stark macht. 

F.N.R. - http://www.spr.ua.pt/fnr/ 

Das Festival Nacional de Robótica (Portuguese Open) fand zum ersten Mal 2001 in Guimarães statt und 
will mit einfachen Roboterwettkämpfen, die einen hohen Unterhaltungswert haben, die Wissenschafts- 
und Technologievermittlung in Grundschulen, weiterführenden Schulen und Hochschulen, aber auch in 
der breiten Öffentlichkeit fördern. Die Portuguese Open werden jedes Jahr in einer anderen Stadt 
veranstaltet und immer mit einem Symposium kombiniert, bei dem Robotikforscher aus dem In- und 
Ausland ihre neuesten Arbeitsergebnisse präsentieren. Die Veranstaltung ist eine Initiative der 
Portugiesischen Gesellschaft für Robotik und verzeichnet seit ihren Anfängen stark steigende Teilnehmer- 
und Zuschauerzahlen. 

RoboParty® – http://www.roboparty.org/ 

Die RoboParty® ist ein Education-Event, bei dem 4-köpfige Teams 3 Tage und 2 Nächte lang mit 
Unterstützung durch qualifizierte Tutoren auf einfache und unterhaltsame Weise lernen, wie man 
autonome mobile Roboter baut. Zum Einstieg wird in einem Crash-Kurs das nötige Basiswissen über 
Elektronik, Roboterprogrammierung und Robotermechanik vermittelt. Anschließend erhalten die 
Teammitglieder einen Roboterbausatz, den die Firma SAR - Soluções de Automação e Robótica und die 
University of Minho gemeinsam entwickelt haben. Diesen Bausatz soll das Team zu einem Roboter 
zusammensetzen (inklusive Mechanik, Elektronik und Programmierung), den es nach der Veranstaltung 
behalten darf. Die Tutoren betreuen sie dabei intensiv, damit am Ende auch jeder Roboter einwandfrei 
funktioniert. 
Ergänzt wird die RoboParty® durch ein Rahmenprogramm mit Sport, Musik, Internetaktivitäten, Spielen, 
Partys und vielem mehr. Übernachtet wird auch gemeinsam – jede Teilnehmerin und jeder Teilnehmer 
bringt einen Schlafsack mit.  

Die RoboParty® ist mit einer Non-Stop-LAN-Party vergleichbar, die allerdings pädagogischen Zwecken und 
der Wissensvermittlung dient. Damit die jungen Teilnehmenden mit dem Roboter, den sie bei der 

http://www.robocup.org/
http://www.spr.ua.pt/site/
http://www.spr.ua.pt/fnr/
http://www.roboparty.org/
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RoboParty gebaut haben, später bei nationalen und internationalen Robotikwettbewerben mitmachen 
können, werden im Rahmen der Veranstaltung auch die Regeln der wichtigsten Turniere erläutert. 

botnroll.com – http://www.botnroll.com/ 

botnroll.com entwickelt Lernprodukte für den Robotikbereich. Diese Produkte bieten einen 
hervorragenden Einstieg für alle, die mehr über Robotik lernen wollen. Für Lehrkräfte an Grundschulen 
und weiterführenden Schulen sind die Produkte von botnroll ideale Hilfsmittel, um in die Themenfelder 
Mechanik, Elektronik und Programmierung einzuführen. Für erfahrene Anwender bietet botnroll auch 
technologisch hochentwickelte mobile Robotiklösungen an.   

http://www.botnroll.com/
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1.3. ELEKTRONIK – BEGRIFFSBESTIMMUNGEN 

Die Elektronik als Wissenschaftszweig untersucht, wie 
man mit Schaltungen aus elektrischen und 
elektronischen Bauteilen Energie umwandelt, 
übermittelt, verarbeitet und speichert.  

Die Elektronik ist der Teilbereich der Physik, in dem 
erforscht wird, was Elektronen sind, wie sie wirken und 
wie sie in elektronischen Geräten genutzt werden. 

Im Wesentlichen untersucht die Elektronik den 
Durchfluss elektronischer Ladungen durch einen 
Halbleiter (nichtmetallischen Leiter).  

 

Die Elektronik eröffnet die Möglichkeit, Energie zu beeinflussen, indem man sie fließen lässt, speichert, 
verteilt oder umwandelt. Außerdem lassen sich mit Hilfe der Elektronik Informationen durch elektrische 
Signale sammeln, verarbeiten, umwandeln, filtern und speichern. 

 

In der Elektrotechnik geht es darum, die Grundprinzipien der Elektronik in Form von Technologien 
anzuwenden, um damit praktische Probleme zu lösen. 

  

Abbildung 4: Elektronische Leiterplatte 
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2. BOT’N ROLL ONE A - KOMPONENTEN 

Wenn Ihr Euren Bot'n Roll ONE A Bausatz zum ersten Mal öffnet, solltet Ihr kontrollieren, ob er auch 
wirklich alle Komponenten enthält – nämlich: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
1- Zwei Antriebsräder 
2- Zwei DC-Motoren 
3- Akku 
4- USB-Kabel zum Anschließen des Roboters an den Computer 
5- Größere Elektronikbauteile 
6- Mechanikbauteile und Laufrad 
7- Akkulader 
8- Zubehör zum Einlegen und Anschließen des Akkus 
9- Acryl-Grundplatte 
10- Leiterplatte 
11- Kleinere Elektronikbauteile 
 

 

WICHTIGER HINWEIS: Falls irgendeine Komponente fehlt, wendet Euch bitte sofort an den Anbieter, der 
den Bausatz geliefert hat, damit die Komponente nachgeliefert wird. 

Abbildung 5: Bot'n Roll ONE A – Elektronikbauteile 
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3. AKKU 

Schließt zuerst den Akku zum Aufladen an, bevor Ihr mit dem Zusammenbauen des Roboters beginnt. So 
sorgt Ihr dafür, dass der Akku einsatzbereit ist, wenn Ihr Euren Roboter fertig gebaut habt! 

Der mitgelieferte Akku ist ein NiMH-Akku (NiMH steht für Nickel-Metallhydrid) mit 12 V Nennspannung 
und 800 mA Nennstrom. 

 

3.1. AKKU AUFLADEN 

Maximale Spannung: Der Akku ist vollständig aufgeladen, wenn die Spannung zwischen 14,5 V und 15 V 
beträgt. 

Mindestspannung Als entladen gilt der Akku, wenn die Spannung weniger als 10 V beträgt. 

Ladestrom Mit dem mitgelieferten Akkulader könnt Ihr auch den Ladestrom festlegen. Empfohlen wird 
ein Ladestrom von höchstens einem Zehntel der Nennkapazität. Für einen Akku mit 800 mA Nennstrom 
beträgt der empfohlene Ladestrom also: 800 mA ÷ 10 = 80 mA. 

Ladedauer: Um die Ladedauer zu berechnen, multipliziert man die Kapazität des Akkus mit dem Faktor 
1,4 und teilt das Ergebnis durch den Ladestrom: 800 x 1,4 ÷ 80 = 14 Stunden Wenn der Ladevorgang 
beendet ist, muss der Akku vom Akkulader getrennt werden. 

Schnellaufladung: Ihr könnt den Akku auch mit einem höheren Ladestrom laden als oben berechnet – das 
kann allerdings dazu führen, dass der Akku heiß wird und sich seine Lebensdauer verkürzt. 

Ladezyklus: Ihr solltet es vermeiden, den Akku nur wenige Minuten oder einige Stunden lang aufzuladen, 
denn das verringert seine Kapazität und verkürzt seine Lebensdauer. Wenn Ihr Euch an die Lade- und 
Entladezyklen haltet, verlängert Ihr damit die Lebensdauer des Akkus. 

Polung: Prüft beim Anschließen des Akkuladers, ob die Polung stimmt („+“ „-“)! 

 

3.2. UMGANG MIT DEM AKKU 

Damit es in Eurem Akku nicht zu einem Kurzschluss kommt, kontrolliert vor dem Einstecken des 
Akkusteckers auf jeden Fall, ob das Akkukabel richtig am Roboter eingesteckt ist. 

Führt auf keinen Fall einen Kurzschluss an den Kontakten des Akkus herbei! Das zerstört den Akku und 
kann sogar zu einem Brand führen. 
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4. BOT’N ROLL ONE A – DAS ZUSAMMENBAUEN 

Das Zusammenbauen des Bot'n Roll ONE A geschieht in drei Schritten: 

1 – Mechanische Montage 
2 – Elektronische Montage 
3 – Elektrische Verkabelung 

TIPP: Schließt zuerst den Akku zum Aufladen an, bevor Ihr mit dem Zusammenbauen des Roboters 
beginnt, damit der Akku nach der Robotermontage gleich einsatzbereit ist. Den Akku vollständig 
aufzuladen, dauert ungefähr 8 Stunden. Lasst den Akku nicht länger als 8 Stunden laden, weil er ansonsten 
Schaden nehmen kann. Da es sich um einen NiMH-Akku handelt, müsst ihr ihn immer komplett aufladen 
und entladen, statt ihn nur wenige Minuten oder eine oder zwei Stunden lang aufzuladen. Kurze 
Ladevorgänge verringern die Kapazität des Akkus und verkürzen seine Lebensdauer. 

 

 
WICHTIGER HINWEIS: Ihr werdet möglicherweise einige Werkzeuge brauchen, die nicht mit dem Bausatz 
mitgeliefert werden: Multimeter (Universal-Messgerät), Kreuzschlitz-Schraubendreher in den Größen 
PH1 und PH2, Flachzange, Lötkolben, Lötdraht, Entlötpumpe, Kombizange. 

 

 

4.1. MECHANISCHE MONTAGE 

Für die mechanische Montage braucht Ihr die Motoren, die Räder, die Motorhalterungen, Radnaben, 
Schrauben und die Acryl-Grundplatte. 
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4.1.1. MOTOREN 

Zum Einbau jedes Motors braucht Ihr jeweils eine 
Motorhalterung mit zwei eingebetteten M3 Muttern, drei 
M3 x 6 mm Kreuzschlitzschrauben (Größe PH1) und zwei 
M3 x 12 mm Kreuzschlitzschrauben (Größe PH1). 

 

 

Ihr braucht einen 1,5-mm-Sechskantschlüssel, den Ihr im 
Beutel mit den mechanischen Bauteilen findet, und einen 
Kreuzschlitz-Schraubendreher (Größe PH1), der nicht 
mitgeliefert wird. 

 

Befestigt den Motor mit den drei kleineren M3 x 6 mm 
Kreuzschlitzschrauben (PH1) an der Motorhalterung. 

Zieht mit dem Kreuzschlitz-Schraubendreher (PH1) alle 
Schrauben an. 

 

 

 

Befestigt mit den beiden längeren M3 x 12 mm 
Kreuzschlitzschrauben (PH1) und den in die Halterung 
eingebetteten M3 Muttern die Motorhalterung mit dem 
angeschraubten Motor an der Acryl-Grundplatte.  

 

 

 

 

In der Acryl-Grundplatte befindet sich eine Öffnung, durch 
die Ihr die Motorkabel hindurchführen müsst, die später 
an die Leiterplatte angeschlossen werden. Führt die Kabel 
so in die Öffnung ein wie in der Abbildung gezeigt. 

 

 

 

   

Abbildung 7: Die L-förmige Motorhalterung wird 
am Motor angebracht 

Abbildung 6: Das braucht Ihr zum 
Einbauen des Motors 

Abbildung 9: Die Motorkabel werden durch die 
Acryl-Grundplatte durchgeführt 

Abbildung 8: Die Motoren werden an der Acryl-
Grundplatte befestigt 
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4.1.2. ANTRIEBSRÄDER 

Zum Fortbewegen benutzt der Bot'n ONE A zwei 
Antriebsräder, die mit den Motoren verbunden werden. 
Sie bestehen aus Kunststoff und einem Gummiüberzug.  

Um die Antriebsräder zu montieren, braucht Ihr für jedes 
Rad jeweils eine formschlüssige „Radnabe“, eine M3 x 3 
mm Sechskantschraube und eine M4 x 6 mm 
Kreuzschlitzschraube (PH2). 

 

Die Motorachse ist nicht komplett rund! Sie hat eine 
flächige Seite, damit Ihr die Schraubnabe mechanisch so 
anbringen könnt, dass sie sich nicht auf der Motorachse 
drehen kann. So sorgt Ihr dafür, dass die gesamte Energie 
des Motors auf die Räder übertragen wird! 
 

 

Bringt die Nabe an der Motorachse an und befestigt sie 
mit einem 1,5-mm-Sechskantschlüssel an der flächigen 
Seite der Motorachse. 

 
 

 

Steckt das Rad auf die Nabe, indem Ihr es an das 
sechseckige Ende der Nabe drückt. 

 

 

 

Befestigt das Rad mit der M4 x 6 mm Kreuzschlitzschraube 
(PH2) an der Nabe und zieht die Schraube fest! 

 

 

 

WICHTIGER HINWEIS: Vergewissert Euch, dass zwischen 
Rad und Motor kein Abstand bleibt, denn sonst wird das 
Bewegungsverhalten des Roboters beeinträchtigt! 

 

Abbildung 10: Diese Teile braucht Ihr zum 
Befestigen der Antriebsräder 

Abbildung 11: Montieren der 
Antriebsräder 
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4.1.3. LAUFRAD 

Das Laufrad wird gebraucht, um den Roboter zu stützen, 
und dient außerdem dazu, die Neigung des Roboters nach 
Bedarf zu verstellen. Die Höhe des Roboters müsst Ihr 
deswegen am „Heck“ einstellen. 

 

Zum Anbringen des Laufrads braucht Ihr zwei M5 x 20 mm 
Kreuzschlitzschrauben (PH2) und sechs M5 Muttern. 

 

 

 

Steckt die Schrauben durch die Acryl-Grundplatte und 
bringt an jeder Schraube jeweils zwei M5 Muttern an.  

 

 

 

Bringt das Laufrad an, indem Ihr die Schrauben in die 
entsprechenden Öffnungen steckt und jede Schraube 
jeweils mit einer der beiden verbliebenen M5 Muttern 
festzieht.  

 

 

Mit Hilfe der M5 Muttern an beiden Seiten des Laufrads 
könnt Ihr die Neigung des Roboters einstellen. 

Vergewissert Euch, dass keine Muttern lose sind und dass 
das Laufrad und die Antriebsräder gleich ausgerichtet 
sind, denn eine Fehlstellung der Räder würde das 
Bewegungsverhalten des Roboters beeinträchtigen. 

 

 

 

Herzlichen Glückwunsch! Den mechanischen Teil der Montage Eures Bot’n Roll ONE A habt Ihr erfolgreich 
abgeschlossen! 

Jetzt könnt Ihr mit der Montage der Elektronik beginnen. 

Abbildung 12: Laufrad, Schrauben und Muttern 

Abbildung 13: Das Laufrad ist montiert und die 
Neigung des Roboters richtig eingestellt 
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Elektronische Montage 

Für die Montage der Elektronik braucht Ihr die 
folgenden (nicht mit dem Roboter mitgelieferten) 
Werkzeuge: 

• Lötkolben 
• Lötdraht 
• Entlötpumpe 
• Kombizange 

 

 

 

 

 

WICHTIGER HINWEIS: In diesem Montageschritt werden alle elektronischen Bauteile an die Leiterplatte 
gelötet. Damit alle Bauteile richtig verlötet werden, empfehlen wir Euch dringend, alle Bauteile genau in 
der Reihenfolge anzulöten, die in dieser Bauanleitung beschrieben wird. Durch fehlerhaftes Verlöten 
können Bauteile oder die Leiterplatte zerstört werden. Deshalb müsst Ihr, bevor Ihr mit dem Löten 
beginnt, den „Crash course on Soldering“ (Crashkurs Löten) absolvieren, den ihr auf der Support-Website 
für den Bot’n Roll ONE A findet. Bitte folgt dazu dem folgenden Link: 
http://botnroll.com/onea_en/soldering/  
 

4.1.4. DIE LEITERPLATTE 

Die Leiterplatte ist mit kleinen Löchern versehen, 
in die Ihr die elektronischen Bauteile einstecken 
müsst. 

Die weiß aufgedruckte Bezeichnung der Bauteile 
gibt die Position und Ausrichtung jedes 
elektronischen Bauteils auf der Leiterplatte an. 

Die Leiterplatte dient als Trägerplatte für die 
elektronischen Bauteile und enthält alle vom 
Schaltplan des Roboters vorgegebenen 
Verbindungen zwischen diesen Bauteilen. 

 

Wenn Ihr die Bauteile einsteckt, müsst Ihr die weißen Aufdrucke beachten – angelötet werden die 
Bauteile aber auf der anderen Seite. Auf der bedruckten Seite brauchen die Bauteile nicht angelötet 
werden, weil die Löcher in der Leiterplatte mit Metall überzogen („plattiert“) sind und den Strom somit 
durchlassen. 

 

Abbildung 14: Das braucht Ihr für die 
elektronische Montage 

Abbildung 15: Die Leiterplatte 
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4.1.5. WIDERSTÄNDE 

Ein elektrischer Widerstand ist ein Bauteil, das den 
Durchfluss von elektrischem (Gleich- oder Wechsel-
)Strom behindert.  

In der Regel wird der Widerstand durch den 
Buchstaben R dargestellt und in Ohm (Ω) gemessen. 

 

Der nominale Widerstandswert wird durch Farbringe (Farbcode) dargestellt, für die Folgendes gilt: Der 
dritte Farbring gibt die Zehnerpotenz an, mit der der Ausgangswert (für den die ersten beiden Ringe 
stehen) multipliziert werden muss; die vierte (etwas nach rechts versetzte) Farbe steht für die Toleranz in 
Prozent. 

 

Farbe 1. Ring 2. Ring 3. Ring 4. Ring 

 1. Zahl 2. Zahl Multiplikator Toleranz % 

Silber   0,01  +/- 10 
Gold   0,1  +/- 5 
Schwarz 0 0 X 1 Farblos +/- 20 
Braun 1 1 X 10 Silber +/- 1 
Rot 2 2 x 100 Gold +/- 2 
Orange 3 3 x 1.000  +/- 3 
Gelb 4 4 x 10.000  +/- 4 
Grün 5 5 x 100.000   
Blau 6 6 x 1.000.000   
Violett 7 7    
Grau 8 8 x 0,1   
Weiß 9 9 x 0,01   

Tabelle 1: Widerstands-Farbcode 

 

Beispiel: Welchen Widerstandswert hat der hier abgebildete Widerstand? 

Die ersten beiden Farben – Gelb (4) und Violett (7) – ergeben den Wert 
47. Die dritte Farbe – Orange (3) – entspricht der Zehnerpotenz 103 
(der Ausgangswert muss also mit 1.000 multipliziert werden), und die 
vierte Farbe – Silber (10 %) – gibt die Toleranz an. Der elektrische 
Widerstand beträgt also: 

R = 47.000 Ω mit 10 % Toleranz oder R = (47.000 Ω ± 4.700 Ω) 

 

 

 

 

 

 

Abbildung 16: Die Farbcodierung auf Widerständen 

Abbildung 17: Der Widerstand für 
unser Berechnungsbeispiel 
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Bitte haltet Euch an die folgende Tabelle, wenn Ihr die Widerstände an die entsprechenden Positionen 
auf der Leiterplatte anlötet: 

 

Lötet die Widerstände mit dem Wert 1 KΩ ± 5 % 
(Farben: Braun, Schwarz, Rot und Gold) an die Positionen R1, R6, R7, R8, 
R13, R14, R16, R17, R18, R19, R20, R22 und R23; 
 
Lötet die Widerstände mit dem Wert 10 KΩ ± 5 % 
(Farben: Braun, Schwarz, Orange und Gold) an die Positionen R3, R4, R5, R11 und 
R12; 
 
Lötet die Widerstände mit dem Wert 120 Ω ± 5 % 
(Farben: Braun, Rot, Braun und Gold) an die Positionen R15, R24 und R25; 
 
Lötet den Widerstand mit dem Wert 1 MΩ ± 5 % 
(Farben: Braun, Schwarz, Grün und Gold) an die Position R21; 
 
Lötet die Widerstände mit dem Wert 3,3 KΩ ± 5 % 
(Farben: Orange, Orange, Rot und Gold) an die Positionen R2, R9 und R10. 

 
 
 
 
 
 
 

 

 

 

Tipp: Steckt zuerst alle Widerstände an 
den richtigen Stellen in die Leiterplatte, 
indem Ihr die Anschlussdrähte jedes 
Widerstands etwas anbiegt.  

Drückt den Widerstand gegen den Tisch, 
bevor Ihr mit dem Löten beginnt.  

Schneidet nach dem Löten die 
Anschlussdrähte so ab, dass sie möglichst 
kurz sind, damit es nicht zu Kurzschlüssen 
kommt. 

 

 

 

Bezeichnung Bauteil 
R1 1 KΩ 
R2 3,3 KΩ 
R3 10 KΩ 
R4 10 KΩ 
R5 10 KΩ 
R6 1 KΩ 
R7 1 KΩ 
R8 1 KΩ 
R9 3,3 KΩ 
R10 3,3 KΩ 
R11 10 KΩ 
R12 10 KΩ 
R13 1 KΩ 
R14 1 KΩ 
R15 120 Ω 
R16 1 KΩ 
R17 1 KΩ 
R18 1 KΩ 
R19 1 KΩ 
R20 1 KΩ 
R21 1 MΩ 
R22 1 KΩ 
R23 1 KΩ 
R24 120 Ω 
R25 120 Ω 

Abbildung 19: Widerstände auf der Leiterplatte 

Abbildung 18: Bot'n Roll ONE A – Widerstände 
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4.1.6. QUARZOSZILLATOR 

Ein Quarzoszillator ist ein elektronisches Bauteil, das die 
Schwingungseigenschaften eines piezoelektrischen Kristalls nutzt, um ein 
elektrisches Signal mit sehr präziser Frequenz zu erzeugen. Der Bot'n Roll 
ONE A verwendet einen 16-MHz-Quarzoszillatorkristall, der dafür sorgt, 
dass der Mikrocontroller ATmega328 bei einer Taktfrequenz von 16 MHz 
arbeitet. Genau wie herkömmliche Armbanduhren, die ebenfalls einen 
Quarz verwenden, ist der Bot'n Roll ONE A dank seines Schwingquarzes ein 
sehr präziser Zeitmesser.  

 

 

 

 

Auf der bedruckten Seite der Leiterplatte ist die Position 
des Quarzoszillators mit „XTAL“ gekennzeichnet. 

 

 

  

Bezeichnung Bauteil 
XTAL 16 MHz Kristall 

Abbildung 20: 
Quarzoszillator 

Abbildung 21: Der Quarzoszillator auf der 
Leiterplatte 
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4.1.7. DIODEN 
 

Eine herkömmliche Diode besteht aus zwei Schichten aus dem gleichen 
Halbleitermaterial: einem n-dotierten Halbleiter mit negativ geladenen 
Ionen (-) und einem p-dotierten Halbleiter mit positiv geladenen Ionen (+). 

Die Haupteigenschaft einer Diode besteht darin, dass sie den elektrischen 
Strom nur in eine Richtung fließen lässt (von links nach rechts, wie in der 
Abbildung gezeigt).   

Die Polung der Diode könnt Ihr an einer Kennzeichnung ablesen, die zur 
jeweiligen Kathodenseite zeigt. Der elektrische Strom fließt von der Anode 
(+) zur Kathode (-) und nicht umgekehrt. 

Die Z-Diode (früher auch Zener-Diode) unterscheidet sich dadurch von 
einer konventionellen Diode, dass sie in festgelegten Situationen in beide 
Richtungen (Durchlassrichtung und Sperrrichtung) betrieben werden 
kann, ohne dass sie dabei beschädigt wird. Der Z-Diode ist eine 
Sperrspannung zugeordnet, die konstant bleibt, wenn der Strom in die 
entgegengesetzte Richtung fließt. Aufgrund dieser Eigenschaften kann sie 
im Bot'n Roll ONE A als Schutzvorrichtung im Messkreis für die 
Akkuspannung eingesetzt werden. Sie dient dort als Spannungsbegrenzer. 
An ihren Anschlussklemmen steigt die Spannung nie über 5,1 V – darum 
wird der PIC18F45K22 nie beschädigt, wenn am Akku eine zu hohe 
Spannung anliegt. 

Die Leiterplatte wird mit zwei verschiedenen Dioden mit den 
folgenden Kennnummern bestückt: 

Die Diode FR203 wird für den Motorantrieb genutzt und sichert 
den Hauptstromkreis des Roboters ab. 

Die Diode Zener 5v1 dient als Schutzvorrichtung für den Akku-
Spannungsmesskreis. 

Die Dioden werden gepolt geschaltet und müssen deshalb in der 
richtigen Ausrichtung positioniert werden! Jede Diode ist mit 
einer Kennzeichnung versehen, die mit der Kennzeichnung 
übereinstimmen muss, die auf die Leiterplatte aufgedruckt ist 
(Fig. 25).  

Die Kennnummer der Diode ist auf dem Bauteil selbst 
aufgedruckt. 

Steckt die Z-Diode an der Position Z1 ein. 

Steckt die Diode FR203 an den folgenden Positionen ein: D1, D2, 
D3, D4, D5, D6, D7, D8, D9, D10, D11 und D12. 

 

Bezeichnung Bauteil 
D1 FR203 
D2 FR203 
D3 FR203 
D4 FR203 
D5 FR203 
D6 FR203 
D7 FR203 
D8 FR203 
D9 FR203 
D10 FR203 
D11 FR203 
D12 FR203 
Z1 Zener 5v1 

Abbildung 25: Anordnung der Dioden 

Abbildung 22: Diode 

Abbildung 23: Z-Diode 

Abbildung 24: Roboter-Dioden 
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4.1.8. POTENTIOMETER 

Ein Potentiometer ist ein veränderbarer Widerstand – sein Wert kann also verstellt 
werden, sodass man die Stromstärke steuern kann, die in einem bestimmten Stromkreis 
fließt. Beim Bot'n Roll ONE A kann man mit Hilfe der Potentiometer die 
Erfassungsreichweite des Hindernissensors sowie den Kontrast und die Helligkeit 
des LCD-Displays einstellen. 

 

Die Leiterplatte wird mit vier 10 KΩ-Potentiometern 
bestückt. 

Der Widerstandswert des Potentiometers ist seitlich 
aufgedruckt, wie in Fig. 27 gezeigt. 

 

 

Die Aufschrift P 103 bedeutet 10.000 Ω, also 10 KΩ. 

 

Das Potentiometer IRD1 regelt die Erfassungsreichweite 
des linken Hindernissensors. 

Das Potentiometer IRD2 regelt die Erfassungsreichweite 
des rechten Hindernissensors. 

Das Potentiometer BR regelt die Helligkeit des LCD-
Displays. 

Das Potentiometer CT regelt den Kontrast des LCD-
Displays. 

 

  

Bezeichnung Bauteil 
IRD1 Potentiometer 10 KΩ 
IRD2 Potentiometer 10 KΩ 
BR Potentiometer 10 KΩ 
CT Potentiometer 10 KΩ 

Abbildung  27: Potentiometer 

Abbildung 26: 
Potentiometer 

http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol_Europe.svg
http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol.svg
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4.1.9. FARBIGE LEDS 

Eine LED („light emitting diode“) besteht aus einem p-n-Übergang 
aus einem Halbleitermaterial und zwei Anschlüssen: der Anode (A, 
positiver Anschluss) und der Kathode (K, negativer Anschluss).  

Die Farbe des emittierten Lichts hängt davon ab, welches 
Halbleitermaterial verwendet wird. 

Ebenso wie Dioden werden auch LEDs gepolt geschaltet. Die 
Kathodenseite (-) ist daran zu erkennen, dass das Gehäuse der LED 
abgeflacht ist und sich dort der kürzere Anschlussdraht befindet. 

Warnung: Schaut nie direkt in den Lichtstrahl einer LED. Auf kurze 
Entfernung ist das Licht so stark, dass es die Netzhaut verletzt und 
irreversibel beschädigt! 

 

Die Leuchtdioden (LEDs) zeigen den Status Eures Bot’n Roll 
ONE A an. 

Die grüne LED ON zeigt an, dass der Roboter eingeschaltet 
ist.  

Die gelben LEDs sind für das „Debugging“ (Fehlersuche und 
Störungsbehebung) bestimmt und werden von Eurem 
Programm gesteuert. 

Die roten LEDs sind mit der Hinderniserkennungs-Schaltung 
verbunden. 

 

Setzt die grüne LED dort ein, wo auf der 
Leiterplatte ON aufgedruckt ist. 

Setzt die gelben LEDs an den Positionen L und 
LED ein. 

Setzt die roten LEDs an den Positionen IRS1 und 
IRS2 ein. 

 

 

 

 

WICHTIGER HINWEIS: Vergesst nicht, dass die LEDs gepolt geschaltet werden! Ihr müsst den längeren 
Anschlussdraht jeder LED dort einstecken, wo auf der Leiterplatte „+“ aufgedruckt ist. 

Bezeichnung Bauteil 
ON LED grün 
L LED gelb 
LED LED gelb 
IRS1 LED rot 
IRS2 LED rot 

Abbildung 29: LEDs 

Abbildung 28: LED 
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4.1.10. IC-SOCKEL FÜR INTEGRIERTE SCHALTUNGEN 

Die IC-Sockel für integrierte Schaltungen sorgen dafür, dass 
integrierte Schaltungen leicht ersetzt werden können, wenn sie 
beschädigt sind. Lötet integrierte Schaltungen niemals direkt an die 
Leiterplatte! 

 

 

Es gibt zwei IC-Sockel – jeweils einen für die 
Mikrocontroller ATmega328 und PIC18F45K22. Diese IC-
Sockel haben 28 beziehungsweise 40 Pole.  

 

 

Jeder IC-Sockel ist an einem Ende mit einer Einkerbung 
versehen, die sich nach dem Einbau über dem 
entsprechenden Aufdruck auf der Leiterplatte befinden 
muss. Beim Einsetzen der IC-Sockel müsst Ihr diese 
Einkerbung unbedingt beachten, denn sie ist sehr 
wichtig für das Aufstecken der integrierten Schaltungen. 
Auch die integrierten Schaltungen haben eine solche 
Einkerbung. Wenn Ihr eine integrierte Schaltung falsch 
herum einsetzt, wird diese dauerhaft beschädigt! 

Die IC-Sockel müssen an den Positionen U1 und U2 
angelötet werden. 

 

 

 

WICHTIGER HINWEIS: Die integrierten Schaltungen ATmega328 und PIC18F45K22 werden erst später in 
die Adapter eingesetzt. Ihr solltet die beiden Schaltungen erst in Schritt 3.3.4 einsetzen, wenn Ihr die 
Leiterplatte fertig verdrahtet habt. 

  

Bezeichnung Bauteil 
U1 28-poliger IC-

Sockel 
U2 40-poliger IC-

Sockel 

Abbildung 30:  
IC-Sockel für integrierte Schaltungen 
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4.1.11. INFRAROTSENDER 

Infrarotsender sind LEDs, die Infrarotlicht ausstrahlen. 
Dieses Licht ist für das menschliche Auge unsichtbar, kann 
die Netzhaut aber genauso beschädigen wie normale LEDs! 

Mit Hilfe einer Videokamera – zum Beispiel einer Webcam 
– kann man überprüfen, ob die LEDs funktionieren oder 
nicht. 

 

 

 

Die Infrarotsender kommen in der Hinderniserkennungs-
Schaltung zum Einsatz. Sie senden Licht aus, das von den 
Hindernissen zurückgeworfen wird. 

 

Setzt die Infrarotsender mit der Wölbung nach außen in 
die Positionen IRE1 und IRE2 ein.  

 

 

4.1.12. DRUCKTASTER 

Ein Drucktaster übermittelt, wenn er gedrückt wird, ein 
elektrisches Signal an den Stromkreis. 

 

 

Für Eure Interaktion mit dem Roboter habt Ihr vier 
Drucktaster zur Verfügung. Damit könnt Ihr zum Beispiel 
in Menüs navigieren und auf ganz einfache Weise 
Programmeinstellungen ändern, ohne Euren Roboter an 
den Computer anzuschließen. 

 

Die Drucktaster PB1, PB2 und PB3 sind für Eure 
Interaktion mit dem Roboter und zum Navigieren in den 
Menüs bestimmt, die auf dem Display angezeigt werden. 

 

Mit der Drucktaste Reset setzt Ihr den Arduino zurück. 

Bezeichnung Bauteil 
IRE1 Infrarotsender 
IRE2 Infrarotsender 

Bezeichnung Bauteil 
PB1 Drucktaster 
PB2 Drucktaster 
PB3 Drucktaster 
Reset Drucktaster 

Abbildung 31: Infrarot-LEDs 

Abbildung 32: Drucktaster 
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4.1.13. HAUPTSCHALTER 

 Ein Schalter ist eine Vorrichtung, die die Stromversorgung des 
Stromkreises unterbricht. 

 

Mit dem Hauptschalter könnt Ihr den Roboter ein- und 
ausschalten. 

Er muss an die Position SW „Switch“ angelötet werden. 

Zum Einschalten des Bot'n Roll ONE A müsst Ihr den 
Schalter in Richtung der Vorderseite des Roboters 
schieben. Wenn Ihr den Schalter in die andere 
Richtung zurückschiebt, schaltet Ihr den Roboter aus! 

 

 

 

 

4.1.14. BUZZER 

Der Buzzer ist ein Wandler, der elektrische Impulse in ein 
akustisches Signal umsetzt. 

 

Mit dem Buzzer kann man Melodien oder akustische 
Warnsignale erzeugen, um zum Beispiel darauf 
hinzuweisen, dass die Akkuspannung zur Neige geht. 

 

 

   

 

  

Bezeichnung Bauteil 
SW Hauptschalter 

Bezeichnung Bauteil 
Buzzer Buzzer 

Abbildung 34: Buzzer 

Abbildung 33: Hauptschalter 
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4.1.15. KERAMIKKONDENSATOREN 

Der Kondensator ist ein Bauteil, das Energie zwischen zwei leitfähigen 
Oberflächen speichert (E = 1/2CV2). In Roboterschaltungen werden 
Kondensatoren zur Energiestabilisierung eingesetzt. 

Die Kapazität (C) eines Kondensators wird durch das Verhältnis der 
gespeicherten Ladung zur Spannung an den Kondensatorklemmen 
bestimmt (C=Q/V). Der Kondensator besteht aus zwei leitfähigen Platten, 
die durch ein isolierendes Material oder Dielektrikum voneinander getrennt 
sind. 

Es gibt monolithische Kondensatoren (ungepolt - links im Bild) und 
Elektrolytkondensatoren (gepolt - rechts im Bild). 

 

 

Der Bot'n Roll ONE A verwendet Keramikkondensatoren 
mit zwei verschiedenen Werten: 22pF und 100nF. 

Der 22pF-Kondensator trägt die Aufschrift „22“ und der 
100nF-Kondensator die Aufschrift „104K“. 

 

 

 

 

 

 

 

 

Steckt die 100nF-Kondensatoren an die Positionen C1, C2, 
C3, C7, C8, C11 und C12. 

Steckt die 22pF-Kondensatoren an die Positionen C9 und 
C10. 

 

 

 

 

Bezeichnung Bauteil Aufschrift 
C1 100 F 104K 
C2 100nf 104K 
C3 100nF 104K 
C7 100nF 104K 
C8 100nF 104K 
C9 22pF 22 
C10 22pF 22 
C11 100nF 104K 
C12 100nF 104K 

Abbildung 36: Keramikkondensatoren 

Abbildung 35: Kondensator 

Abbildung 37: Anordnung der 
Kondensatoren 
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4.1.16. BIPOLARTRANSISTOREN 

Ein Transistor ist ein Halbleiterbauteil, mit dem elektrische Signale verstärkt oder geschaltet werden. Beim 
Bot'n Roll ONE A werden Transistoren in der Hinderniserkennungs-Schaltung eingesetzt, um die 
Lichtleistung der Infrarot-LEDs zu erhöhen. 

Ein Transistor besteht aus drei p- und n-dotierten 
Halbleiterschichten und hat drei Anschlüsse: Emitter, Basis und 
Kollektor (im Schaltbild abgekürzt durch die Buchstaben E, B 
und C). Je nach Anordnung der drei p- und n-dotierten 
Halbleiterschichten unterscheidet man zwischen pnp- oder 
npn-Transistoren.  

Wenn der Transistor als Verstärker eingesetzt wird, wird der  
zwischen der Basis und dem Emitter fließende Strom (Eingang) 
verstärkt und fließt dann zwischen Kollektor und Emitter (Ausgang). Wenn der Transistor als Schalter 
verwendet wird, schaltet das Basiseingangssignal das Ausgangssignal. Je nach Anschlusskonfiguration 
des Transistors kann das verstärkte oder geschaltete Ausgangssignal gegenüber dem Eingangssignal 
invertiert werden oder auch nicht. 

 

 

Die beiden PNP BC557 Transistoren werden an den Positionen 
Q1 und Q2 angebracht. 

 

Diese Bauteile werden in den Stromkreis der 
Infrarotsender eingebaut und dienen dort als 
Schalter, mit denen der PIC18F45K22 die 
Infrarot-LEDs ausschalten und mit hoher 
Lichtleistung einschalten kann. Auf diese Weise 
können auch weit entfernte Hindernisse erfasst 
werden!  

 

 

Transistoren besitzen eine Polarität! Sie arbeiten nur dann einwandfrei, wenn sie korrekt in die 
Schaltung eingebaut werden.  

Die flache Seite des Transistors muss sich dort befinden, wo auf der Leiterplatte die gerade Linie 
aufgedruckt ist. 

 

Bezeichnung Bauteil 
Q1 BC557 Transistor 
Q2 BC557 Transistor 

Abbildung 39: BC557B PNP Transistor 

Abbildung 38: npn-Bipolartransistor 

http://en.wikipedia.org/wiki/File:NPN_BJT_(Planar)_Cross-section.svg
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4.1.17. JUMPER (KURZSCHLUSSBRÜCKEN) 

Ein Jumper ist ein Verbindungsstecker, mit dem man den 
Roboter elektrisch konfigurieren kann, weil er den 
elektrischen Strom zu bestimmten Bereichen des 
Stromkreises leitet. 

 

 

Der Bot'n Roll ONE A verfügt über einen Jumper mit 2 
Steckplätzen und zwei Jumper mit jeweils einem Steckplatz. 

 

Mit Hilfe des „Servo Power“ -Jumpers mit 2 Steckplätzen (SPOW) 
könnt Ihr wählen, ob die Servos vom Spannungsregler 7805 oder 
vom Spannungsregler PWR versorgt werden sollen. 

 

Der Jumper BUZ verbindet den Buzzer mit dem I/O-Pin 9 des 
Arduino. 

 

Der Jumper SSP sorgt im gesteckten Zustand dafür, dass der 
Arduino und der PIC über den I/O-Pin 2 des Arduino als „Slave 
Select“ des SPI-Kommunikationsbusses miteinander 
kommunizieren können. 

 

 

  

Bezeichnung Bauteil 
SPOW Jumper mit 2 

Steckplätzen 
BUZ Jumper mit 1 

Steckplatz 
SSP Jumper mit 1 

Steckplatz 

Abbildung 40: Jumper 
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4.1.18. ARDUINO-STECKVERBINDER 

An die fünf Steckverbinder können Arduino-kompatible 
„Shields”(Aufsteckplatinen) wie das Wireless XBee 
Communication Shield angeschlossen werden. 

Lötet jeden der fünf Steckverbinder jeweils an die Reihen, 
die genauso viele Steckplätze haben wie der 
Steckverbinder. Vergewissert Euch, dass die 
Steckverbinder richtig ausgerichtet sind und die 
Leiterplatte berühren!  

Jeder der fünf Arduino-Steckverbinder hat eine 
bestimmte Funktion: 

Der Steckverbinder VIN-IOREF ist der Arduino Power 
Connector. Hier stehen alle Spannungen für die 
Stromkreise des Roboters zur Verfügung:   5 V, 3,3 V, VIN 
(Akkuspannung) und GND (0 V). Der RESET-Pin ist mit der 
Reset-Taste des Arduino verbunden, während IOREF für 
zukünftige Aufsteckplatinen reserviert ist. 

Auf dem Steckverbinder A0-A5 befinden sich die 
Analogeingänge des Arduino Analog-Digital-Wandlers 
(kurz „ADC“ für „Analog to Digital Converter“). Hier könnt 
Ihr analoge Sensoren anschließen, deren Signal zwischen 
0 V und 5 V variiert. Mit nur wenigen Programmzeilen 
erhaltet Ihr den entsprechenden digitalen Wert. Falls Ihr 
mit I2C-Kommunikation arbeitet, könnt Ihr die Pins A4 
und A5 nicht als Eingänge für den Analog-Digital-Wandler 
nutzen, da diese Pins dann für die I2C-Kommunikation 
reserviert sind. 

Neben dem Steckverbinder A0-A5 findet Ihr eine Gruppe von Dreifachanschlüssen, die die gleiche A0-A5-
Kennzeichnung aufweisen. Hier könnt Ihr analoge Sensoren anschließen, die ebenfalls Spannungen 
zwischen 0 V und 5 V brauchen. An dieser Gruppe von Steckverbindern entsprechen die „s“-Pins den 
Analogeingängen, während „-“ den 0 V und „+“ den 5 V entspricht. 

An den Steckverbindern 0-7 und 8-SCL findet Ihr die Digitaleingänge und -ausgänge (I/O) des Arduino. 
Jeder dieser Pins kann per Software als Digitaleingang oder -ausgang konfiguriert werden. An jeden der 
Ausgänge 0 bis 13 könnt Ihr ein 0-V-Signal oder 5-V-Signal anlegen, das dem Zustand Low beziehungsweise 
High entspricht. Die Pins mit dem Symbol „~“ – zum Beispiel ~3 – könnt Ihr als PWM-Ausgänge definieren, 
oder Ihr könnt darüber Servomotoren wie zum Beispiel den Servomotor am Greifer steuern. Wenn Ihr 
diese Pins als Digitaleingänge konfiguriert, um zum Beispiel digitale Sensoren daran anzuschließen, könnt 
Ihr an jedem dieser Pins kontrollieren, ob Ihr 5 V oder 0 V habt. Die Pins SCL und SDA werden für die I2C-
Kommunikation verwendet und entsprechen den Pins A4 und A5 des Steckverbinders A0-A5. Den Pin 
AREF solltet Ihr nur benutzen, wenn Ihr eine externe Referenzspannung für die Wandlungen des Analog-
Digital-Wandlers braucht, aber diese Spannung kann nur zwischen 0 V und 5 V variieren! 

Neben den Steckverbindern 0-7 und 8-SCL findet Ihr eine Gruppe von Dreifachanschlüssen mit der 
gleichen 0-7- und 8-SCL-Kennzeichnung. Hier könnt Ihr digitale Sensoren und Aktoren anschließen, die 

Bezeichnung Bauteil 
ICSP 2x3 Stecker 
A0-A5 1x6 Buchse 
VIN-IOREF 1x8 Buchse 
0-7 1x8 Buchse 
8-SCL 1x10 Buchse 

Abbildung 40: Arduino-Steckverbinder 
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Spannungen zwischen 0 V und 5 V brauchen. An dieser Gruppe von Steckverbindern entsprechen die „s“-
Pins den digitalen Pins, während „-“ den 0 V und „+“ den 5 V entspricht. 

Der Steckverbinder ICSP ermöglicht die SPI-Kommunikation mit den aufgesteckten Shields und die 
Programmierung des Arduino Bootloaders per ICSP (In Circuit Serial Programming).  
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4.1.19. LEISTUNGSSTECKVERBINDER (POWER CONNECTORS) 

 Mit den Leistungssteckverbindern könnt Ihr den Akku 
und die Motoren an die Leiterplatte anschließen. Die 
Drähte müssen mit Schrauben gesichert werden. 

 

 

Steckt die Steckverbinder mit Hilfe der Schlitze zu einem 
einzigen Stecker mit sechs Anschlüssen zusammen. 

 

Steckt alle Steckverbinder an die entsprechenden Stellen 
und lötet alle Anschlüsse an die Leiterplatte. 

 

 

An MotorL könnt Ihr den linken Motor, an MotorR den 
rechten Motor und an Bat den Akku anschließen. 

 

 

4.1.20. SICHERUNG UND SICHERUNGSHALTER 

Eine Sicherung ist eine Schutzvorrichtung mit einem Leiter 
aus Metall, der schmilzt, sobald der durch diesen Leiter 
fließende Strom den festgelegten Wert überschreitet. 

 

Zum Schutz gegen Kurzschlüsse wird eine 4A-Sicherung 
mit einem Sicherungshalter verwendet. Sobald der vom 
Akku gelieferte Strom 4A überschreitet, brennt die 
Sicherung durch. 

Legt die träge 4A-Sicherung in den Deckel des 
Sicherungshalters ein. 

 

Der Sicherungshalter muss an der Position F1 
in die Leiterplatte eingesteckt werden. 

Steckt den Deckel mit der eingelegten Sicherung auf den 
Sicherungshalter.  

Bezeichnung Bauteil 
MotorL Steckverbinder für den 

linken Motor 
Bat Akkustecker 
MotorR Steckverbinder für den 

rechten Motor 

Bezeichnung Bauteil 
F1 Sicherungshalter 

Abbildung 41: 
Anordnung der Leistungssteckverbinder 

Abbildung 42:  
Die Sicherung wird in die Schaltung eingebaut 



Bot’n Roll ONE A Bauanleitung   

© Copyright 2016, SAR - Soluções de Automação e Robótica, Lda. 33 

4.1.21. ELEKTROLYTKONDENSATOREN 

Elektrolytkondensatoren sind gepolte Bauteile! Deswegen müsst 
Ihr, wenn Ihr sie an der Leiterplatte anbringt, ihre Polung beachten. 

 

Sie sollten so an den Positionen C4 und C5 eingesteckt 
werden, dass der längste Anschlussdraht in die Öffnung 
mit dem aufgedruckten „+“-Zeichen eingesteckt wird.  

 

Der Wert der Kondensatoren beträgt 100 μF. 

 

 

4.1.22. I2C-STECKVERBINDER 

Mit Hilfe dieser Steckverbinder könnt Ihr Geräte 
anschließen, die mit dem Kommunikationsprotokoll I2C 
arbeiten – wie zum Beispiel Kompasse, 
Beschleunigungsmesser, Ultraschallsensor, Temperatur- 
und Feuchtigkeitssensoren usw. 

 

Bringt die Steckverbinder an den Positionen I2C1 und 
I2C2 an. Bitte beachtet, dass die aufgedruckte 
Markierung für das senkrechte Kunststoffteil des 
Steckverbinders steht.  

 

 

 

4.1.23. USB-SERIELL-WANDLER 

 Der USB-Seriell(RS232)-Wandler sorgt dafür, dass Ihr den 
Roboter über einen USB-Computeranschluss programmieren 
könnt. 

 

Er wird dort aufgesteckt, wo „USB“ aufgedruckt ist. 

 

 

Bezeichnung Bauteil 
C4 100 µF 
C5 100 µF 

Bezeichnung Bauteil 
I2C1 KK 1x4 Stecker 
I2C2 KK 1x4 Stecker 

Bezeichnung Bauteil 
USB USB-Wandler 

Abbildung 43: 
Elektrolytkondensatoren 

Abbildung 45: USB-Wandler 

Abbildung 44: I2C-Steckverbinder 
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4.1.24. KÜHLKÖRPER 

Ein Kühlkörper ist ein Metallobjekt, das die Arbeitstemperatur 
eines Bauteils verringert. Er verhindert, dass das Bauteil durch zu 
hohe Temperaturen beschädigt wird, und verlängert die 
Lebensdauer des Bauteils. 

 

Bringt den Spannungsregler LM7805 mit der 
mitgelieferten Schraube und der ebenfalls mitgelieferten 
Mutter am Kühlkörper an. Dabei müssen die glatte 
Innenfläche des Kühlkörpers und die Metallfläche des 
LM7805 aneinander liegen. 

 

4.1.25. SPANNUNGSREGLER 

 Die Bauteile LM7805 und LD33CV sind lineare Spannungsregler, 
die bestimmte Spannungen für die Stromversorgung des 
Schaltkreises liefern. 

 Der 7805 dient als Stromquelle für die Geräte, die mit 5 Volt 
arbeiten, während der LD33 die Geräte versorgt, die mit 3,3 Volt 
arbeiten. 

 

 

Setzt den LM33CV dort ein, wo „LD33“ aufgedruckt ist, und 
platziert den LM7805 dort, wo „7805“ aufgedruckt ist. 

 

Wenn Ihr den LM7805 anlötet, muss der Kühlkörper schon 
angebracht sein! 

 

Bitte achtet auf die richtige Ausrichtung der Bauteile. Hinweis: 
Die aufgedruckte Doppellinie steht für den Metall-Kühlkörper des 
Bauteils. 

 

  

Bezeichnung Bauteil 
7805 LM7805 
LD33 LD33CV 

Bezeichnung Bauteil 
7805 LM7805 
LD33 LD33CV 

Abbildung 47: Die Spannungsregler LD33 
  

Abbildung 46: Kühlkörper 
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4.1.26. DIE H-BRÜCKE L298 

Das Bauteil L298N entspricht einer Doppel-H-Brücke, die jeden 
Motor des Roboters einzeln antreibt und für die 
Geschwindigkeitsregelung und Richtungslenkung verantwortlich 
ist. 

Dieses Bauteil lässt für den Dauerbetrieb an jeder H-Brücke eine 
maximale Stromstärke von 2 A zu. Für kurze Momente (bis zu 100 
us) kann er jeden Motor mit 3 A ansteuern. 

 

 

 

 

Setzt den L298N dort ein, wo „U3“ aufgedruckt ist.  

 

 

 

 

 

4.1.27. INFRAROTEMPFÄNGER 

Die Infrarotempfänger sind Sensoren, die das Infrarotlicht 
erfassen, das von Hindernissen zurückgeworfen wird. 
Emittiert wird dieses Licht von den Infrarot-LEDS als ein mit 
38 kHz moduliertes Signal - jede LED geht also 38.000 Mal pro 
Sekunde an und aus! Wenn die LEDs das Licht nicht mit dieser 
Frequenz aussenden, können die Infrarotempfangssensoren 
keine Hindernisse erkennen. 

 

Zwei Infrarotempfänger werden – anders als alle 
anderen Bauteile, die Ihr bisher angelötet habt – an 
der Unterseite der Leiterplatte angebracht. 

 
Steckt die Empfänger des Typs SHARP GP1UX511QS an 
der Unterseite der Leiterplatte dort ein, wo IRR1 (für 
„Infra-Red Receiver1“) und IRR2 aufgedruckt ist. Die 
Sensoren müssen so nach außen gerichtet sein, wie in 
der Abbildung 49 gezeigt. 
 
 
Angelötet werden müssen diese Empfänger – im 
Gegensatz zum bisherigen Vorgehen – an der 
Oberseite der Leiterplatte.  

Bezeichnung Bauteil 
U3 L298N 

Bezeichnung Bauteil 
IRR1 SHARP 

GP1UX511QS 
IRR2 SHARP 

GP1UX511QS 

Abbildung 48: Die integrierte 
Schaltung L298N  

Abbildung 49 Infrarotempfänger 
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4.1.28. LCD-DISPLAY 

Über das LCD-Display können Roboter und Benutzer zum Beispiel 
mit Hilfe von schriftlichen Nachrichten interagieren und 
Programmzustände oder den Wert bestimmter Variablen 
kommunizieren. 

Der Bot'n Roll ONE A LCD hat ein alphanumerisches LCD-Display 
mit zwei Zeilen à 16 Zeichen. Kontrast und Helligkeit sind 
veränderbar. 

 

Für die Befestigung des Displays werden eine 16-polige 
Stiftleiste, zwei M3x10 Kreuzschlitzschrauben (PH1), zwei 
Nylon-Abstandhalter und zwei M3 Muttern mitgeliefert. 

Damit Ihr das Display anbringen könnt, müsst Ihr das 
Plattenelement entfernen, das die Aussparung ausfüllt, in 
die das Display eingebaut werden soll. Wenn nötig, glättet 
die Aussparung mit einer Feile oder mit Sandpapier, damit 
das Display genau hineinpasst. 

Das Display wird von der Unterseite der Leiterplatte des 
Bot'n Roll ONE A aus eingesetzt. Bevor Ihr das Display 
einsetzt, fügt die 16-polige Stiftleiste mit den längeren 
Pins nach unten zwischen das Display und die Leiterplatte. 

Setzt das Display in die Platte ein und bringt die beiden 
Schrauben, Nylon-Abstandhalter und Muttern an, wie in 
der Abbildung gezeigt, und befestigt das Display dann an 
der Leiterplatte, indem Ihr die Schrauben festzieht. 

Vergewissert Euch, dass sich die 16-polige Stiftleiste quasi 
wie ein Sandwich zwischen dem Display und der 
Leiterplatte des Bot'n Roll ONE A befindet und dass sich 
die Pins der Stiftleiste in den Löchern der „LCD“-
Verbindung auf der Leiterplatte des Roboters befinden. 

Kontrolliert, ob das Display waagerecht ausgerichtet ist, 
und lötet die 16-polige Stiftleiste an die Leiterplatte des 
Bot'n Roll ONE A. Anschließend lötet Ihr die 16 Pins, die 
sich unterhalb der Leiterplatte befinden, an das Display. 
 

 

Das Plattenelement, das Ihr aus der Leiterplatte 
herausgenommen habt, wurde extra so gestaltet, dass 
Ihr es als unverwechselbaren Schlüsselanhänger 
verwenden könnt! 

Bezeichnung Bauteil 
LCD-Display 1x16 

Steckverbinder 

Abbildung 50: Das LCD-Display wird 
eingesetzt 
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4.1.29. SCHUTZGEHÄUSE FÜR DEN USB-SERIELL-WANDLER  

Der USB-Seriell-Wandler ist ein Bauteil, das durch das 
Einstecken und Herausziehen des USB-Kabels andauernd 
physisch beansprucht wird. Als „Einfassung“ und Schutz 
für den USB-Seriell-Wandler wurde deswegen ein 
Kunststoffgehäuse aus Polylactid (PLA) entwickelt, das 
mit einem 3D-Drucker hergestellt wird. Dieses Gehäuse 
sorgt dafür, dass der Wandler unversehrt bleibt. 

 

 

 

Bringt das Schutzgehäuse aus Kunststoff so am USB-
Seriell-Wandler an, dass der USB-Anschluss für das Kabel 
noch zu sehen ist. Überprüft, ob sich die beiden Löcher 
an der Unterseite des Schutzgehäuses genau über den 
Löchern in der Leiterplatte des Roboters befinden. 

 

 

 

 

Steckt die beiden M3 x 6 mm Schrauben in die Löcher und 
schraubt sie mit einem Kreuzschlitz-Schraubendreher 
(PH1) in das Schutzgehäuse aus Kunststoff ein. Zieht die 
Schrauben so lange an, bis die Unterseite des 
Schutzgehäuses die Leiterplatte des Roboters berührt, 
aber zieht sie nicht zu fest an, weil Ihr sonst womöglich 
den Kunststoff zermalmt! 

Vergewissert Euch, dass die Schrauben nicht mit den 
Lötstellen in Berührung kommen – sonst könnte es zu 
Kurzschlüssen kommen! 

 

 

Jetzt ist der USB-Seriell-Wandler gut geschützt und fit für 
den Alltagseinsatz! 

 

 
Abbildung 51: So wird das Schutzgehäuse für 

den USB-Seriell-Wandler angebracht 
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4.2. VERDRAHTEN UND PRÜFEN 

4.2.1. AKKU ANSCHLIESSEN 

SEHR WICHTIGER HINWEIS:  

Ein Kurzschluss am Akku kann einen Brand auslösen! 

Schließt den Akku auf keinen Fall an den Roboter an, bevor 
Ihr mit allen Anschlussarbeiten fertig seid!  

Bevor Ihr die Schrauben löst, mit denen das Akkukabel am 
„Bat“-Anschluss befestigt ist, vergewissert Euch, das der 
Akku NICHT an das Kabel angeschlossen ist!  

 
Der Akkustecker wird in die mit „Bat“ bezeichnete 
Anschlussöffnung eingesteckt. Das rote Kabel muss dort 
angeschlossen werden, wo das „+“-Zeichen aufgedruckt 
ist; das schwarze Kabel wird an „–“ angeschlossen. In 
diesem Fall ist die Polung EXTREM wichtig! 

Für die Kabeldurchführung vom Unterbau des Roboters 
zur Leiterplatte ist die Öffnung in der Mitte der Acryl-
Grundplatte bestimmt. 

 

 

 

4.2.2. ELEKTRISCHE MONTAGEKONTROLLE 

Schließt jetzt den aufgeladenen Akku an den Roboter an 
und kontrolliert, ob die ON-LED an- und ausgeht, wenn Ihr 
den Hauptschalter betätigt.  

Kontrolliert mit einem Spannungsprüfer, ob im Arduino 
Power Connector (VIN-IOREF) die Spannungen 5 V, 3,3 V 
und VIN (Akkuspannung) anliegen. Ihr solltet die 
Spannung immer bezogen auf GND messen – das 
entspricht 0 V. 

Wenn eine der genannten Vorgaben nicht erfüllt ist, heißt 
das, dass Euch beim Zusammenbauen ein Fehler 
unterlaufen ist. Diesen Fehler solltet Ihr zuerst beseitigen, 
bevor Ihr zum nächsten Schritt übergeht. In der 
nachfolgenden Übersicht haben einige Tipps 
zusammengestellt, die Euch helfen sollen, ein 
aufgetretenes Problem zu lösen: 

Abbildung 52: So werden die Akkukabel 
eingesteckt 

 

  

 

Abbildung 53: Die LED leuchtet 



Bot’n Roll ONE A Bauanleitung   

© Copyright 2016, SAR - Soluções de Automação e Robótica, Lda. 39 

 

 

 

Mögliche Ursache/Beobachteter Fehler Lösung 

Der Akku ist nicht richtig in den Steckverbinder 
eingesteckt. 

Steckt den Akku richtig ein und kontrolliert, ob die 
Lasche des Steckers eingerastet ist. 

Die Akkukabel sind nicht ordnungsgemäß an 
die Leiterplatte des Bot’n Roll ONE A 
angeschlossen. 

Kontrolliert, ob die Kabel sicher an dem mit „Bat“ 
gekennzeichneten Anschluss befestigt sind, und führt 
eine Durchgangsprüfung mit dem Multimeter durch. 

Die Sicherung ist nicht in den Stromkreis 
eingesteckt. 

Steckt die Sicherung so ein, wie in Abschnitt 3.2.17 
dieser Bauanleitung beschrieben. 

Die Sicherung ist durchgebrannt. Sehr wahrscheinlich gab es einen Kurzschluss auf der 
Leiterplatte. Kontrolliert die Lötstellen, findet und 
beseitigt den Kurzschluss, bevor Ihr eine neue 
Sicherung einsetzt. 

Die Sicherung ist nicht durchgebrannt, aber 
die grüne ON-LED leuchtet nicht auf, oder am 
Arduino Power Connector liegt überhaupt 
keine Spannung an. 

In diesem Fall liegt möglicherweise immer noch ein 
Kurzschluss vor, aber der Strom reicht nicht aus, um 
die Sicherung durchbrennen zu lassen. Überprüft die 
Temperatur der Spannungsregler 7805 und LD33. 

Einer der beiden Spannungsregler ist zu heiß. Sehr wahrscheinlich liegt ein Kurzschluss vor. 
Kontrolliert die Lötstellen, findet und beseitigt den 
Kurzschluss. Es besteht immer noch eine geringe 
Möglichkeit, dass ein Bauteil beschädigt wird. 

Die Spannungsregler werden nicht warm, die 
ON-LED leuchtet nicht auf, oder am Power 
Connector des Arduino liegt keine Spannung 
an. 

Wahrscheinlich gibt es fehlerhafte Lötstellen, sodass 
die Bauteile und die Leiterplatte nicht richtig in 
Kontakt sind. Sucht nach sogenannten „kalten 
Lötstellen“, an denen der Lötdraht nicht glänzt, und 
lötet mit dem Lötkolben nach, bis Ihr seht, dass das 
Lötmetall vollständig schmilzt. Nehmt, wenn nötig, 
mehr Lötmetall hinzu. 

Die Spannungsregler sind nicht warm 
geworden, am Power Connector liegen 
Spannungen an, aber die ON-LED leuchtet 
nicht auf.  
Am Arduino Power Connector liegt Spannung 
an, aber die ON-LED leuchtet nicht auf. 

Ihr solltet Euch vergewissern, dass die ON-LED 
polgerecht angelötet wurde, dass also der längste 
Anschlussdraht an „+“ angeschlossen ist. Kontrolliert 
die Polung der ON-LED mit einem Multimeter. 

Nach Prüfung aller genannten Möglichkeiten 
besteht das Problem immer noch. 

Wendet Euch an den Kundendienst auf botnroll.com. 

 

 

 

 

 

 

 

http://www.botnroll.com/
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4.2.3. EINSETZEN DER INTEGRIERTEN SCHALTUNGEN 

Eine integrierte Schaltung ist ein elektronischer Schaltkreis im 
Miniaturformat, der hauptsächlich aus Halbleiterbauteilen wie zum 
Beispiel Transistoren besteht. Wie viele Transistoren sich in einer 
integrierten Schaltung befinden, kann sehr unterschiedlich sein – 
von einigen wenigen Transistoren bis zu Zehnmillionen von 
Transistoren. 

 

An Eurem Roboter kommen zwei integrierte Schaltungen 
im DIP-Format zum Einsatz: 

PIC18F45K22: 40-poliger Prozessor (PIC). 
 
ATmega328: 28-poliger Prozessor (Arduino). 

HINWEIS: Bevor Ihr die integrierten Schaltungen einbaut, 
vergewissert Euch, dass der Bot'n Roll ONE A 
ausgeschaltet ist. 

 
Es kann sein, dass Ihr die Pins der integrierten Schaltungen 
zuerst richtig justieren müsst, bevor Ihr sie in die IC-Sockel 
einsetzt. Geht dabei bitte vorsichtig zu Werk, denn die 
Pins sind empfindlich und können abbrechen, wenn sie 
nicht sachgemäß behandelt oder mehrmals gebogen 
werden – dadurch werden sie unter Umständen 
irreparabel beschädigt. 
 
 
WICHTIGER HINWEIS:  
Die integrierten Schaltungen lassen sich nur in einer 
einzigen, ganz bestimmten Position einsetzen. An einer 
der Kanten gibt es eine kleine Aussparung, die der 
aufgedruckten Markierung auf der Leiterplatte entspricht. 
Steckt den ATmega328 an die Position U1 und den 
PIC18F45K22 an die Position U2. 
 
 

 

  

Bezeichnung Bauteil 
U1 ATmega328 
U2 PIC18F45K22 

Abbildung 54 So werden die integrierten 
Schaltungen eingesetzt 
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4.2.4. DIE LEITERPLATTE AN DER ACRYL-GRUNDPLATTE BEFESTIGEN 

 

Um die Leiterplatte des Roboters an der Acryl-
Grundplatte anzubringen, braucht Ihr 6 
Befestigungssätze mit jeweils einem 12-mm-Nylon-
Abstandhalter, einer M3 x 8 Kreuzschlitzschraube (PH1) 
und einer M3 x 4 Kreuzschlitzschraube (PH1). 

 

Setzt jede M3 x 8 Kreuzschlitzschraube von unten nach 
oben in die Acryl-Grundplatte ein und schraubt einen 
Nylon-Abstandhalter darauf, bis er festgeschraubt ist. 

Wiederholt den Vorgang für alle anderen fünf 
Abstandhalter. 

 

 

Setzt die Leiterplatte an, führt dabei die Motorkabel 
durch das Loch in der Mitte und befestigt die 
Leiterplatte mit den M3x4 Kreuzschlitzschrauben, indem 
ihr diese in die Nylon-Abstandhalter hineinschraubt. 

Zieht die Schrauben mit einem Kreuzschlitz-
Schraubendreher fest, bis zwischen der Leiterplatte, den 
Nylon-Abstandhaltern und der Acryl-Grundplatte keine 
Zwischenräume mehr bleiben. 

 

4.2.5. DIE MOTOREN ANSCHLIESSEN 

Zum Anschließen der Motoren dienen die 
Steckverbinder MotorL und MotorR. Der linke Motor 
wird an MotorL und der rechte Motor an MotorR 
angeschlossen. 

WICHTIGER HINWEIS: Die Motorkabel sind schwarz 
und rot. Es ist sehr wichtig, dass diese Kabel korrekt 
angeschlossen werden, weil die Polung darüber 
entscheidet, in welche Richtung sich der Motor dreht. 
Bei fehlerhafter Polung kann es sein, dass sich der 
Roboter nicht so bewegt, wie Ihr es von ihm erwartet! 

Das rote Kabel muss an „+” und das schwarze Kabel an 
„–“ angeschlossen werden.  

Abbildung 56: So wird die Leiterplatte an 
der Acryl-Grundplatte befestigt 

Abbildung 57: Die Anschlüsse für die Motoren 

Abbildung 55: Mit diesen Teilen wird 
die Leiterplatte an der Acryl-

Grundplatte befestigt 
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4.2.6. AKKU EINSETZEN 

Der Akku wird mit drei Klettstreifen an der Unterseite der 
Acryl-Grundplatte befestigt. 

Bevor Ihr die Klettstreifen anbringt, vergewissert Euch 
bitte, dass der entsprechende Bereich nicht klebrig, 
verschmutzt oder fettig ist!  

Wenn nötig, reinigt die Oberflächen mit einem 
Glasreiniger und lasst sie anschließend vollständig 
trocknen! 

Drückt die beiden Klettstreifen fest an den Akku, damit er 
gut daran haften bleibt. Anschließend müsst Ihr den 
Klebeschutz entfernen, um den Akku am Roboter 
anzubringen. 
 
Drückt den Akku noch einmal fest an den Bot'n Roll ONE 
A, damit er gut daran haftet. Achtet darauf, dass die 
Bauteile auf der Leiterplatte des Roboters nicht 
beschädigt werden! 
 
Wenn der Akku mit den Klettstreifen befestigt und 
vollständig aufgeladen ist, schließt den Stecker an – jetzt 
könnt Ihr den Bot'n Roll ONE A programmieren! 
 
 
Kompliment – gut gemacht!  

 

 

 

 

 

  

Abbildung 58:  
So wird der Akku angebracht 
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5. VCP-TREIBER FÜR DEN USB-SERIELL(RS232)-WANDLER INSTALLIEREN 

Dieser Treiber sorgt dafür, dass das Betriebssystem Eures Computers mit dem Bot'n Roll ONE A 
kommunizieren kann. 

Um den Treiber zu installieren, geht auf die Support-Website für den Bot’n Roll ONE A auf 
http://botnroll.com/onea/ und ladet Euch den „VCP Driver - Windows“ oder den „VCP Driver - Mac OS 
X“ herunter, indem Ihr den Link anklickt, der zu Eurem Betriebssystem passt. Nach dem Download 
entpackt Ihr die „.zip“-Datei und startet die Anwendung. 

Jedes Mal, wenn Ihr Euren Roboter mit dem USB-Kabel an Euren Computer anschließt, wird ein virtueller 
COM-Port (VCP) erzeugt, über den die Kommunikation zwischen Eurem Bot'n Roll ONE A und Eurem PC 
abgewickelt wird. Die Umgebung für die Anwendungsprogrammierung nutzt den Port für die 
Kommunikation mit dem Bot'n Roll ONE A und überträgt zu diesem Zweck Eure Programme auf den 
Roboter. 

Bei dem USB-Seriell-Wandler, den der Bot'n Roll ONE A verwendet, handelt es sich um einen PoUSB12 
von PoLabs, der mit der Bridge CP2102 von Silicon Labs arbeitet. 

 

6. DIE ARDUINO-PROGRAMMIERUMGEBUNG 

Programmiert wird der Roboter mit der Software Arduino IDE. Diese Anwendung wird benötigt, damit Ihr 
die Programme in der Programmiersprache C editieren könnt. Die Software wird auch dazu verwendet, 
Eure Programme auf den Bot’n Roll ONE A zu überspielen. 

6.1. ARDUINO IDE INSTALLIEREN 

Um die Software Arduino IDE zu installieren, geht bitte auf die Support-Website für den Bot’n Roll ONE A 
auf http://botnroll.com/onea/ und klickt dort auf „Arduino IDE - Windows“ oder „Arduino IDE - Mac OS 
X“, um die für Euer Betriebssystem passende Software herunterzuladen. 

Nach dem Download entpackt die .zip-Datei und kopiert sie in einen Ordner Eurer Wahl auf Eurem 
Computer. 

Dieser Ordner enthält mehrere Unterordner und Dateien – darunter auch die Anwendung „arduino“. 
Diese ausführbare Datei startet die Software Arduino IDE. Sehr wichtig ist auch der Unterordner 
„libraries“: Er enthält alle Arduino-Libraries. Die Libraries sind Euer Handwerkszeug für das 
Programmieren. 

6.2. DIE LIBRARY BNRONEA AUF ARDUINO INSTALLIEREN 

Die Library BnrOneA wurde von botnroll.com für Arduino IDE entwickelt und enthält alle nötigen Befehle 
für die Steuerung des Roboters. Diese Library muss auf Arduino IDE installiert werden. 

Ladet Euch von der Support-Website für den Bot’n Roll ONE A auf http://botnroll.com/onea/ die Datei 
Arduino Library herunter, indem Ihr auf „BnrOneA.zip“ klickt. 

Entpackt die Datei und speichert den extrahierten Ordner „BnrOneA“ im Verzeichnis „libraries“, das im 
vorhergehenden Abschnitt beschrieben wurde. Jetzt habt Ihr alles, was Ihr braucht, um Euren Bot'n Roll 
ONE A erfolgreich zu programmieren! 

http://botnroll.com/onea/
http://botnroll.com/onea/
http://botnroll.com/onea/
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6.3. DIE KOMMUNIKATION MIT DEM ROBOTER KONFIGURIEREN 

Bevor Ihr diesen Schritt in Angriff nehmt, vergewissert Euch bitte, dass Ihr den VCP-Treiber korrekt 
installiert habt. Schließt den Bot'n Roll ONE A mit dem mitgelieferten USB-Kabel an Euren Computer an. 
Jetzt wird automatisch ein COM-Port für die Kommunikation mit dem Roboter zugewiesen. 

 

Öffnet jetzt Arduino IDE, klickt auf die Option 
„Tools -> Board“ und wählt unter „Board“ 
(Leiterplatte) „Arduino Uno“ aus. Der Bot´n 
Roll ONE A wird nun so programmiert, als wäre 
er ein Arduino Uno. 

 

 

 

Wählt unter „Tools -> Serial Port“ den richtigen 
COM-Port aus, der dem Bot'n Roll ONE A 
zugewiesen wurde. 

 

 

 

Falls hier kein COM-Port angeboten wird, habt Ihr vermutlich den VCP-Treiber für den USB-Seriell-
Wandler nicht korrekt installiert. 

Öffnet den Windows Gerätemanager und sucht nach dem 
Eintrag „Anschlüsse (COM and LPT)“. Wenn Ihr diesen 
Eintrag anklickt, werden alle verfügbaren 
Kommunikationsanschlüsse (COM-Anschlüsse) angezeigt. 

„Silicon Labs CP210x USB to UART Bridge“ ist die 
Bezeichnung für den Kommunikationsanschluss, der mit 
dem Bot’n Roll ONE A „sprechen“ kann (in dem 
abgebildeten Beispiel wurde der Port COM5 zugewiesen). 

 

Wenn der Eintrag „Silicon Labs CP210x USB to UART 
Bridge“ nicht in der Liste erscheint, müsst Ihr den VCP-
Treiber korrekt installieren. 

 

  
Abbildung 61: Kommunikationsanschlüsse 
(COM-Ports) im Windows Gerätemanager 

Abbildung 60: Den seriellen Port auswählen 

Abbildung 59: Die Leiterplatte auswählen, die 
programmiert werden soll 
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6.4. EIN PROGRAMM AUF DEN BOT'N ROLL ONE A LADEN 

In der Anwendung Arduino IDE findet Ihr verschiedene Beispielprogramme, die Ihr auf Euren Roboter 
laden könnt.  

 

Klickt auf „File -> Examples -> 01.Basics -> 
Blink“. Es öffnet sich ein neues Fenster mit 
dem Code für das gewählte Beispiel.  

 

 

 

Klickt auf „File -> Upload“ oder auf das Pfeil-
nach-rechts-Symbol, um das Programm an 
den Roboter zu senden. Sobald der Upload 
abgeschlossen ist, muss die gelbe LED im 
Sekundentakt blinken! 

 

 

 

Wenn Ihr auf „File -> Examples -> BnrOneA-> ...“ klickt, findet Ihr alle Programme, die botnroll.com 
speziell für den Bot'n Roll ONE A entwickelt hat. 

Unter „File -> Examples -> BnrOneA-> Basic 
-> ...“ findet Ihr die einfachsten Programme, 
die vor allem dazu dienen, um die 
komplette Hardware Eures Roboters zu 
testen. Mit diesen kleinen Programmen 
müsst Ihr Euch gründlich vertraut machen! 

Unter „File -> Examples -> BnrOneA-> 
Advanced -> ...“ gibt es einige 
fortgeschrittenere Programme, die für Euch 
womöglich erst verständlich sind, wenn Ihr 
mit den Basisprogrammen vertraut seid. 

Unter „File -> Examples -> BnrOneA-> Extra 
-> ...“ findet Ihr Programme, die mit den 
Extras des Bot'n Roll ONE A 
zusammenhängen, die Eurem Roboter viele 
weitere Entfaltungsmöglichkeiten eröffnen. 

 

 

Abbildung 62: Ein Beispielprogramm laden 

Abbildung 63: Ein Programm an den Roboter 
senden 

Abbildung 64:  
Programme aus der Library BnrOneA  
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7. DER HARDWARE-TEST FÜR EUREN BOT'N ROLL ONE A 

 
Wenn Euer Roboter den elektrischen Test (Abschnitt 3.3.2 in dieser Bauanleitung) erfolgreich bestanden 
hat, müssen alle Bauteile Eures Bot'n Roll ONE A einzeln getestet werden, um festzustellen, ob sie alle 
einwandfrei funktionieren. Dafür müsst Ihr den Roboter mit den entsprechenden Beispielcodes 
programmieren und alle Tests durchführen, die nachfolgend Punkt für Punkt aufgelistet werden. Bitte 
geht dabei zwar genau in der hier vorgegebenen Reihenfolge vor! 
 
 

7.1. „L“-LED 

 
Öffnet in Arduino IDE das Beispielprogramm „Blink“ unter „File -> Examples -> 01.Basics -> Blink“ und 
programmiert den Roboter, indem Ihr auf „Upload“ klickt. Wenn der Upload beendet ist, muss die L-LED 
im Sekundentakt blinken. 
 
Wenn die L-LED nicht aufleuchtet, kontrolliert bitte, ob es einen Kurzschluss oder eine fehlerhafte 
Lötstelle an einem der folgenden Bauteile gibt:  

• L-LED; 
• Widerstand R16; 
• Pin 13 des Arduino Steckverbinders 8-SCL; 
• IC-Sockel der integrierten Schaltung ATmega328.  

 
Vergewissert Euch, dass Ihr beim Verlöten der L-LED die Polung beachtet habt. Um das zu überprüfen, 
könnt Ihr entweder ein Multimeter verwenden oder die internen Verbindungen der LED mit einer 
identischen LED vergleichen. 
 
 
 

7.2. BUZZER 

 
Ladet das Programm „Buzzer“ unter „File -> Examples -> BnrOneA -> Basic -> Buzzer“ auf den Roboter. 
Wenn der Upload beendet ist, solltet Ihr eine Melodie hören, die der Buzzer ertönen lässt. Dies zeigt, dass 
der Buzzer einwandfrei funktioniert. 
 
Sollte der Buzzer keine Melodie spielen, kontrolliert bitte, ob sich der BUZZ-Jumper an der richtigen Stelle 
befindet und ob es einen Kurzschluss oder eine fehlerhafte Lötstelle an einem der folgenden Bauteile gibt: 

• Buzzer; 
• Widerstand R15; 
• BUZZ-Jumper; 
• IC-Sockel der integrierten Schaltung ATmega328.  

 
  



Bot’n Roll ONE A Bauanleitung   

© Copyright 2016, SAR - Soluções de Automação e Robótica, Lda. 47 

7.3. DEBUG-LED 

 
Ladet das Programm „LED“ unter „File -> Examples -> BnrOneA -> Basic -> LED“ auf den Roboter. Wenn 
der Upload beendet ist, sollte die LED im Sekundentakt blinken. 
 
Falls die LED nicht leuchtet, müsst Ihr die folgenden Bauteile auf Kurzschlüsse oder fehlerhafte Lötstellen 
überprüfen: 

• LED-LED; 
• Widerstand R18; 
• Pin 13 des Arduino Steckverbinders 8-SCL; 
• SSP-Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  

 
Vergewissert Euch, dass Ihr beim Verlöten der LED-LED die Polung beachtet habt. Um das zu überprüfen, 
könnt Ihr entweder ein Multimeter verwenden oder die internen Verbindungen der LED mit einer 
identischen LED vergleichen. 
 
 
 
 

7.4. LCD-DISPLAY 

 
Ladet das Programm „LCD“ unter „File -> Examples -> BnrOneA -> Basic -> LCD“ auf den Roboter. Wenn 
der Upload beendet ist, solltet Ihr auf dem Display die Meldung „LCD Test OK!!“ sehen. 
 
Falls diese Meldung nicht erscheint, kontrolliert bitte Folgendes: 

• Steht der Hauptschalter des Roboters auf ON? 
• Habt Ihr mit dem Potentiometer BR die Helligkeit des LCD-Displays richtig eingestellt? 
• Habt Ihr mit dem Potentiometer CT den Kontrast des LCD-Displays richtig eingestellt? 

 
Wenn Ihr dies kontrolliert habt und die Meldung trotzdem nicht auf dem Display erscheint, überprüft 
bitte die folgenden Bauteile auf Kurzschlüsse oder fehlerhafte Lötstellen: 

• 16-polige Stiftleiste des LCD-Displays; 
• Potentiometer BR; 
• Potentiometer CT; 
• SSP-Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  
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7.5. DRUCKTASTER 

 
Ladet das Programm „PushButtons“ unter „File -> Examples -> BnrOneA -> Basic -> PushButtons“ auf den 
Roboter. Wenn der Upload beendet ist, erscheint auf dem Display die Nummer des Drucktasters, den Ihr 
gerade drückt: 

• 0, wenn kein Drucktaster gedrückt wird 
• 1, wenn der Drucktaster PB1 gedrückt wird 
• 2, wenn der Drucktaster PB2 gedrückt wird 
• 3, wenn der Drucktaster PB3 gedrückt wird 

 
 
Wenn irgendeiner der Drucktaster nicht einwandfrei funktioniert, überprüft bitte die folgenden Bauteile 
auf Kurzschlüsse oder fehlerhafte Lötstellen: 

• Schalter PB1; 
• Schalter PB2; 
• Schalter PB3; 
• Widerstand R6; 
• Widerstand R7; 
• Widerstand R8; 
• SSP-Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  

 
 
 
 

7.6. AKKU 

 
Ladet das Programm „Battery“ unter „File -> Examples -> BnrOneA -> Basic -> Battery“ auf den Roboter. 
Wenn der Upload beendet ist, sollte auf dem Display die Batteriespannung angezeigt werden. 
 
Falls der angezeigte Spannungswert nicht zwischen 9,0 V und 14,0 V beträgt, kontrolliert bitte 
Folgendes: 

• Steht der Hauptschalter des Roboters auf ON? 
• Ist der Akku aufgeladen? 
• Befindet sich an der Position R2 der Widerstand mit 3,3 KΩ? 
• Befindet sich an der Position R3 der Widerstand mit 10 KΩ? 
• Habt Ihr die Z-Diode Z1 in der richtigen Ausrichtung angebracht? 

 
Wenn Ihr dies kontrolliert habt und das Problem weiterhin besteht, überprüft bitte die folgenden 
Bauteile auf Kurzschlüsse oder fehlerhafte Lötstellen: 

• Kondensator C1; 
• Widerstand R2; 
• Widerstand R3; 
• Diode Z1; 
• SSP-Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  
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7.7. MOTOREN 

 
Ladet das Programm „Motors“ unter „File -> Examples -> BnrOneA -> Basic -> Motors“ auf den Roboter. 
Wenn der Upload beendet ist, sollten die Motoren anlaufen und auf dem LCD eine Meldung erscheinen, 
die die ausgeführte Bewegung beschreibt. 
 
Sollte sich der Motor nicht in Bewegung setzen, kontrolliert bitte Folgendes: 

• Steht der Hauptschalter des Roboters auf ON? 
• Ist der Akku aufgeladen? 
• Ist der Steckverbinder MotorL festgezogen? 
• Ist der Steckverbinder MotorR festgezogen? 
• Sind die Radnaben richtig an den Motoren angebracht? 
• Sind die Räder des Roboters richtig an den Radnaben befestigt? 

 
Wenn Ihr dies kontrolliert habt und das Problem weiterhin besteht, überprüft bitte die folgenden 
Bauteile auf Kurzschlüsse oder fehlerhafte Lötstellen: 

• Kondensator C2; 
• Dioden D2, D3, D4, D5, D6, D7, D8 und D9; 
• Steckverbinder MotorL; 
• Steckverbinder MotorR; 
• Integrierte Schaltung U3 (L298N); 
• SSP-Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  

 

 

7.8. INFRAROT-LEDS 

 
Ladet das Programm „IR_Emitters“ unter „File -> Examples -> BnrOneA -> Basic -> IR_Emitters“ auf den 
Roboter. Wenn der Upload beendet ist, blinken die Infrarot-LEDs im Sekundentakt, und auf dem LCD-
Display wird die entsprechende Statusinformation angezeigt. 
 
Kontrolliert mit der Kamera eines Mobiltelefons (ohne Infrarotfilter), ob die LEDs blinken, denn für das 
menschliche Auge ist Infrarotlicht unsichtbar. 
 
Wenn einige der Infrarot-LEDs kein Licht aussenden, verstellt das entsprechende Potentiometer (IRD1 für 
IRE1 und IRD2 für IRE2), bis Ihr seht, dass die LED Licht aussendet. 
 
Wenn Ihr dies kontrolliert habt und das Problem weiterhin besteht, überprüft bitte die folgenden 
Bauteile auf Kurzschlüsse oder fehlerhafte Lötstellen: 

• IRE1-LED; 
• Transistor Q1; 
• Potentiometer IRD1; 
• Widerstände R13 und R24; 
• IRE2-LED; 
• Transistor Q2; 
• Potentiometer IRD2; 
• Widerstände R19 und R25; 
• SSP Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  
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7.9. HINDERNISSENSOREN 

 
Ladet das Programm „ObstaclesCalibration“ unter „File -> Examples -> BnrOneA -> Basic -> 
ObstaclesCalibration“ auf den Roboter. Wenn der Upload beendet ist, senden die Infrarot-LEDs 
Infrarotlicht aus, das – wenn es von einem Hindernis zurückgeworfen wird – dazu führt, dass die IRS1- 
und IRS2-LEDs blinken. 
 
Auf dem LCD-Display erscheint eine Meldung, die über die Hinderniserkennung Auskunft gibt: 

• 0, wenn kein Sensor ein Hindernis erkennt; 
• 1, wenn der linke Sensor ein Hindernis erkennt; 
• 2, wenn der rechte Sensor ein Hindernis erkennt; 
• 3, wenn der linke und der rechte Sensor ein Hindernis erkennen. 

 
Haltet Eure Hand vor die Infrarot-LEDs, um ein Hindernis zu simulieren, und kontrolliert, ob die IRS1- und 
IRS2-LEDs blinken und gleichzeitig die entsprechende Meldung auf dem LCD-Display erscheint. 
 
Wenn einige der IRS1- oder IRS2-LEDs nicht blinken, überprüft bitte die folgenden Bauteile auf 
Kurzschlüsse oder fehlerhafte Lötstellen: 

• IRS1 LED; 
• IRR1 Sensor; 
• R14 Widerstand; 
• IRS2 LED; 
• IRR2 Sensor; 
• R20 Widerstand; 
• SSP Jumper; 
• IC-Sockel der integrierten Schaltung PIC18F45K22 
• IC-Sockel der integrierten Schaltung ATmega328.  

 
Vergewissert Euch, dass Ihr die IRS1- oder IRS2-LEDs mit der richtigen Polung eingebaut habt. Um das zu 
überprüfen, könnt Ihr entweder ein Multimeter verwenden oder die internen Verbindungen der LED mit 
einer identischen LED vergleichen. 
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7.10. DIE HINDERNISERKENNUNGS-SCHALTUNG KALIBRIEREN 

 
Ladet das Programm „ObstaclesCalibration“ unter „File -> Examples -> BnrOneA -> Basic -> 
ObstaclesCalibration“ auf den Roboter. Wenn der Upload beendet ist, senden die Infrarot-LEDs 
Infrarotlicht aus, das – wenn es von einem Hindernis zurückgeworfen wird – dazu führt, dass die IRS1- 
und IRS2-LEDs blinken. 
 
Auf dem LCD-Display erscheint eine Meldung, die über die Hinderniserkennung Auskunft gibt: 

• 0, wenn kein Sensor ein Hindernis erkennt; 
• 1, wenn der linke Sensor ein Hindernis erkennt; 
• 2, wenn der rechte Sensor ein Hindernis erkennt; 
• 3, wenn der linke und der rechte Sensor ein Hindernis erkennen. 

 
Stellt den Roboter so auf, dass er ein Hindernis vor sich hat – zum Beispiel eine Wand oder ein Blatt Papier 
– und kalibriert die Entfernung für die Hinderniserkennung, indem Ihr mit einem Kreuzschlitz-
Schraubenzieher die Potentiometer IRD1 und IRD2 einstellt. 
 
Bitte beachtet:  

• Beim Einstellen müsst Ihr euch von den Angaben auf dem LCD-Display leiten lassen und nicht 
von den IRS1- und IRS2-LEDs, weil die LEDs immer blinken, bevor die Software das Hindernis 
erkennt. 

• Dunkle Gegenstände werfen weniger Licht zurück als helle Gegenstände. Wenn Ihr die 
Entfernung für einen hellen Gegenstand einstellt, ist diese Entfernung nicht geeignet zum 
Erkennen eines dunklen Gegenstandes! 

 

Jetzt ist Euer Bot'n Roll ONE A komplett und einsatzbereit! Lasst Eurem Einfallsreichtum freien Lauf und 
erkundet die fantastische Welt der Robotik… Herzlichen Glückwunsch! 
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8. EXTRAS 

Ihr könnt Euren Bot'n Roll ONE A mit verschiedensten Extras kombinieren, die die Funktionsvielfalt des 
Roboters erweitern. Arduino-kompatible Shields (Aufsteckplatinen) wie Wireless XBee, Bluetooth, RF, 
GPS, GPRS und Sensoren wie Linienfolger, Ultraschallsensor, Kompass, Encoder und jedes beliebige I2C-
Bauteil können Euren Bot'n Roll ONE A angebaut werden. Der Fantasie sind kaum Grenzen gesetzt! 

Ausführliche Beschreibungen zu einigen dieser Komponenten findet Ihr in der „Zusatzbauanleitung“. 
Diese Zusatzbauanleitung könnt Ihr Euch auf der Support-Website für den Bot’n Roll ONE A auf 
http://botnroll.com/onea/ besorgen. 

Weitere Informationen findet Ihr außerdem auch auf www.botnroll.com.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Abbildung 65 Der Bot'n Roll ONE A mit angebauten Extras 
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9. ANHANG 

9.1. BOT'N ROLL ONE A – LISTE DER ELEKTRONIKBAUTEILE 

 

Anzahl       Bezeichnung Anzahl       Bezeichnung 
3 120 Ohm Widerstand 1 LM7805CT IC 

13 1K Ohm Widerstand 1 LD33CV IC 
3 3,3K Ohm Widerstand 1 28-poliger IC-Sockel 
5 10K Ohm Widerstand 1 40-poliger IC -Sockel 
1 1M Ohm Widerstand 2 Infrarot-LED 
4 10K Potentiometer 2 Infrarotempfänger Sharp GP1UX511QS 
1 3 mm LED grün 1 USB-Seriell-Wandler POUSB12 
2 3 mm LED rot 2 PNP BC557 Transistor 
2 3 mm LED gelb 1 Buzzer – Magnetischer Wandler  
2 22pF-Kondensator 1 16 x 2 LCD-Display 
7 100nF-Kondensator 1 16-polige Steckleiste 
2 100uF 25V Kondensator 4 Drucktaster 
1 16 MHz Quarz 1 Hauptschalter 

12 FR203 Diode 1 10-polige Buchse 
1 5V1 Z-Diode 2 8-polige Buchse 
1 Träge Sicherung 3A 20 x 5 mm 1 6-polige Buchse 
1 Sicherungssockel 1 3 x 2 Stecker 
1 Sicherungshalterdeckel 2 KK 4-poliger KK-Steckverbinder 
1 ATmega328 IC 3 2-poliger Schraubsteckverbinder 
1 PIC18F45K22 IC 2 2-poliger Jumper 
1 L298N IC 1 3-poliger Jumper 
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9.2. SCHALTPLAN 
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